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Slide 1 

 
PowerPoint Tips – Before you begin… 
Save this version before you make any changes to it – this will be the ‘master’ version that 
you can always revert to if you make a mistake. 

We suggest that you print this version and make changes to the printed version before you 
change an actual PowerPoint file.  

Change the footer to the title of your state project: 

Go to “View” > “Header and Footer.”  A box should appear.   

Toward the bottom of the box will be a check box that is checked and says “footer.”   
Directly below that box is a place to type in your new footer.  It should currently read “Your 
State Project.”  

Insert your title here then click on “apply to all.”  
Change the title of the presentation; add your name, date and location of the presentation 
by clicking on the text and typing them in.  

When making these changes, we would appreciate acknowledgement of Building 
Partnerships for Youth’s role in creating this toolkit.  

Here is a blurb that can be used:  

“This presentation is based upon a template created by the Building Partnerships for 
Youth project (BPY).  This project is a collaboration of National 4-H Council and the 
University of Arizona.  The purpose of BPY is to provide youth development 
resources and support to organizations working with young people ages 9 to 13.”  

Optional 
To insert your own logo: 

You must have your logo saved on your computer. 

Chose “Insert” from the top menu bar. 

Then choose “Picture” > “From file.”  
Next: Browse your computer for your logo image. 

Once you select your file, the image will be placed on the PowerPoint slide. 

Resize and place the logo in a place that will not block the content – the top right corner 
may be a good spot. 

Once you have it where you would like, copy that image – Keyboard shortcut: Ctrl-C. 
Select the next slide – Keyboard shortcut: “Page Down” button. 

"Your State Project"

“Title of Presentation”

“Presenter name”
“Affiliation Name”

In partnership with
Building Partnerships for Youth

“Date of Presentation”
“Location of Presentation”

"Your State Project"

“Title of Presentation”

“Presenter name”
“Affiliation Name”

In partnership with
Building Partnerships for Youth

“Date of Presentation”
“Location of Presentation”
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And paste the image – Keyboard shortcut: Ctrl-V. 

Keep repeating “Page Down” > “Paste” until the logo is placed on all the slides. 

Hint: Keyboard shortcuts are your friend, get to know them! 
To change the background color: 

Select from top menu bar – Format > Background. 

Press the “down arrow”’ in the dialogue box. 

Select a new color. 

Click “apply to all.” 
Hints: use backgrounds which contrast from the color of the text, e.g., light-colored text on 
a dark background works very well, while light text on a light background does not. 

Try to make the PowerPoint easy to read from a long distance. 

Slide 2 

"Your State Project"

Project Partners

• Project Partner 1

• Project Partner 2

• Project Partner 3

 
Note to Facilitator:  
In many cases it is a good idea to involve state or community partners in these types of 
efforts.   

Click on the text, delete the current text and type in the names of your project partners onto 
this slide.  

Be sure to acknowledge the unique contributions of each partner. 

PowerPoint Tip 
The pictures included in this PowerPoint may be modified to better reflect your community. 

By choosing “Insert” > “Picture” > “from file” and then browsing for photos on your 
computer, you can change the included photos. 
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Slide 3 

"Your State Project"

Objectives of this Presentation
• To discuss the importance of non-school-hour 

youth development programming.

• To partner, coordinate, and collaborate with 
other youth-serving organizations in order to 
increase access to non-school-hour youth 
development programming.

• To develop an action plan that will continue the 
process started today.

 
Note to Facilitator:   
These are Building Partnerships for Youth’s suggested objectives.   

If your project has different objectives, change the template to reflect your needs. 

 

Slide 4 

"Your State Project"

Project Background

“Insert your community’s 
prior youth development 
work here”

 
Note to Facilitator:  
It is likely that some prior work in your state or community served as the background for 
this presentation.  If that is the case, it is important that your audience be aware of this 
work.  This presentation is an excellent tool to help people develop a shared understanding 
of local youth development activities.   

To insert information about local projects, click on the text, delete what is currently there 
and type in the new text. 

 

Slide 5 

"Your State Project"

Positive Youth Development is:

“Caring adults engaged with youth in meaningful 
activities which foster the development of 
agency, connectedness, and competence.”

Building Partnerships for Youth

 
Note to Facilitator:  
This definition comes from the Building Partnerships for Youth project.   

It was developed based on a review of over 100 different definitions of youth development.  
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Slide 6 

"Your State Project"

Positive Youth Development is:

• Adults from families and wider communities
• Not necessarily professional youth workers
• Relationships in which youth feel supported / 

valued

Caring adults engaged with youth in meaningful 
activities which foster the development of agency, 
connectedness, and competence.

 
Note to Facilitator:  
“Caring adults” are those who are engaged with youth.   

We are referring to adults in the community who may or may not be professional youth 
workers; they may be volunteers, mentors, or possibly youth professionals.  

These adults work to develop relationships with youth in which youth feel supported and 
really valued. 

What this recognizes is that youth development is a process that involves people across 
young peoples’ families and wider communities, people that provide the supports and 
opportunities young people need throughout this developmental process. 

 

Slide 7 

"Your State Project"

Positive Youth Development is:

• Relationships distinguished by mutuality
• Emphasize contributions of youth, not problems
• Appreciation of different strengths and 

competencies

Caring adults engaged with youth in meaningful 
activities which foster the development of agency, 
connectedness, and competence.

 
Note to Facilitator:  
“Engaged WITH youth”—not doing for or doing to youth, but encouraging relationships 
distinguished by mutuality and emphasizing the contributions that youth can make rather 
than their problems. These are relationships where youth and adults collaborate together, 
with one another, but also with an understanding and appreciation of the different strengths 
and competencies each bring to the relationship.  
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Slide 8 

"Your State Project"

Positive Youth Development is:

• Young people find challenging and valuable
• Allow youth real decision-making power
• Not just activities that adults don’t want to do

Caring adults engaged with youth in meaningful 
activities which foster the development of agency, 
connectedness, and competence.

 
Note to Facilitator:  
“Meaningful activities” are ones that young people themselves find challenging and 
valuable, and may concern issues or policies which face them or affect their daily lives.  
These are activities in which youth have real decision-making power, and in this process, 
their voices and perspectives are heard and welcomed. 

These are NOT tasks that young people are assigned to do because adults don’t want to 
do them. 

 

Slide 9 

"Your State Project"

Positive Youth Development is:

• Capacity to be self-directed
• Comfort in working with people of different ages, 

cultures and backgrounds
• Includes a sense of responsibility and control

Caring adults engaged with youth in meaningful 
activities which foster the development of agency, 
connectedness, and competence.

 
Note to Facilitator:  
“The development of agency” - By engaging in meaningful activities with caring adults and 
peers in which young people are afforded the power to make decisions about issues that 
affect their lives and their communities, young people develop agency, or the capacity to 
act and interact, to be self-directed in situations that require comfort in working with people 
of different ages, cultures, and backgrounds. They learn how to exercise responsibility and 
gain a heightened sense of control over their lives, as well as a sense of accountability for 
their actions and an understanding of the consequences of their decisions… 
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Slide 10 

"Your State Project"

Positive Youth Development is:

• Sense of belonging and inclusion
• To peers and adults in families, schools, 

neighborhoods, and communities
• Social responsibility, cooperation, interest in and 

compassion for others

Caring adults engaged with youth in meaningful 
activities which foster the development of agency, 
connectedness, and competence.

 
Note to Facilitator:  
Young people also develop a sense of “connectedness”—to their peers and adults within 
their families, schools, neighborhoods, and communities. This connectedness may be seen 
as a sense of belonging and inclusion with others, and a sense of social responsibility, 
cooperation, interest in and compassion for others… 

Slide 11 

"Your State Project"

Positive Youth Development is:

• Skills to function successfully and contribute 
meaningfully

• Includes numerous individual skills and sets of 
skills

• Contributes to development of self-confidence 
and the ability to face challenges and take 
initiative

Caring adults engaged with youth in meaningful 
activities which foster the development of agency, 
connectedness, and competence.

 
Note to Facilitator:  
“Competence”— which consists of the development of a wide range of skills, or sets of 
skills, that allow young people to function successfully and contribute meaningfully within 
their lives. 

Slide 12 

"Your State Project"

What the Experts Say…

“Prevention/early intervention is an attempt 
to shift the balance from vulnerability to 
resilience, either by decreasing exposure 
to risk factors and stressful life events, or 
by increasing the number of available 
protective factors in the lives of vulnerable 
children.” 

Emmy Werner
The Children of Kauai

 
Note to Facilitator:   
Relevant Research  

     Werner, E. E. (1992). The children of Kauai: Resiliency and recovery in adolescence 
and adulthood. Journal of Adolescent Health, 13, 262-268.  

This article provides an update to the 1955 study of Kauai children by Werner, who 
followed nearly 700 children from birth to adulthood. Werner examines the concepts of risk 
and resilience for high-risk, low-income children in the study. 
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Slide 13 

"Your State Project"

Why is Positive Youth Development Important?

Youth are less likely to: 
• use illicit drugs,
• get in trouble with the law, and 
• engage in other problem 

behaviors.

Blum, R.W., Beuhring,T., Rinehart, P.M., (2000). Protecting teens: Beyond race, income and family structure, Center For Adolescent Health, University of Minnesota, 
200 Oak Street SE, Suite 260, Minneapolis, MN. Retrieved September 12, 2005 from http://ideanet.doe.state.in.us/sdfsc/pdf/protectingteens.pdf

Hawkins, J. D., Catalano, R. F., Kosterman, R., Abbott, R., & Hill, K. G. (1999). Preventing adolescent health-risk behaviors by strengthening protection during 
childhood. Archives of Pediatrics and Adolescent Medicine, 153(3), 226-234. 

 
Note to Facilitator:  
Relevant Research  

     Blum, R.W., Beuhring,T., Rinehart, P.M., (2000). Protecting teens: Beyond race, income 
and family structure, Center For Adolescent Health, University of Minnesota, 200 Oak 
Street SE, Suite 260, Minneapolis, MN. Retrieved September 12, 2005 from 
http://ideanet.doe.state.in.us/sdfsc/pdf/protectingteens.pdf 
This on-line document provides a comprehensive overview of the factors associated with 
youth involvement in health risking behaviors. 

     Hawkins, J. D., Catalano, R. F., Kosterman, R., Abbott, R., & Hill, K. G. (1999). 
Preventing adolescent health-risk behaviors by strengthening protection during childhood. 
Archives of Pediatrics and Adolescent Medicine, 153(3), 226-234.  

 

Slide 14 

"Your State Project"

Why is Positive Youth Development Important?

Youth are more likely to: 
• do well in school, 
• gain skills, and 
• contribute to their communities.

 
Note to Facilitator:  
Relevant Research  

     Pittman, K. J., Irby, M., & Ferber, T. (2000). Unfinished business: Further reflections on 
a decade of promoting youth development. In Youth development: Issues, challenges and 
directions. (pp. 17-64). Philadelphia: Public/Private Ventures. Retrieved Jan. 30, 2001 from 
http://www.ppv.org/content/youthdev.html. 
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Slide 15 

"Your State Project"

What the Experts Say…

“All young people need a 
variety of experiences to 
develop to their full potential.”

National Research Council

 
Note to Facilitator:  
Relevant Research  

National Research Council and Institute of Medicine (2002). Community Programs to 
Promote Youth Development. Committee on Community-Level Programs for Youth. 
Jacquelynne Eccles and Jennifer Appleton Gootman, (Eds.). Board on Children, Youth, 
and Families, Division of Behavioral and Social Sciences and Education, National 
Research Council and Institute of Medicine. Washington, D.C.: National Academy Press.  

Community Programs to Promote Youth Development focuses on essential elements of 
adolescent well-being and healthy development. It offers recommendations for policy, 
practice, and research to ensure that programs are well designed to meet young people's 
developmental needs. 

 

Slide 16 

"Your State Project"

How Can We Create Positive Youth Development 
Opportunities?

• Provide safe places for youth to go: after-school 
programs, extracurricular activities, community centers

• Provide places for youth to do challenging things:  academic support/mentoring; 

• Provide service learning; youth empowerment/organizing; career development; culture, 
arts and media; recreation

• Provide places for youth to do these things with caring adults and with supportive peers

• Provide, most fundamentally, places that seek to promote positive youth development.

 
Note to Facilitator:  
The next several slides are an appropriate place to provide examples of youth 
development programming in your state or community, either on the slide or in your 
discussion/presentation.  

Relevant Research  

     Kirby, D., Lezin, N., Afriye, R.A., & Gallucci, G. (2003). Preventing teen pregnancy: 
Youth development and after-school programs. Scotts Valley, CA: ETR Associates.  

Preventing Teen Pregnancy: Youth Development and After-School Programs began as an 
evaluation of YWCA adolescent pregnancy prevention programs. Over time, it evolved into 
a broader guide, one that not only captured the real-world experiences of various 
programs, but also stepped back to ask why different programs might be effective, how to 
choose different program components, and how to combine them.  
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Slide 17 

"Your State Project"

How Can We Create Positive Youth Development 
Opportunities?

• Provide safe places for youth to go: after-school programs, extracurricular activities, 
community centers

• Provide places for youth to do challenging things:  
academic support/mentoring;

• Provide service learning; youth empowerment/organizing; career development; 
culture, arts and media; recreation

• Provide places for youth to do these things with caring adults and with supportive 
peers

• Provide, most fundamentally, places that seek to promote positive youth 
development.

 
Note to Facilitator:  
This slide is an appropriate place to provide examples of youth development programming 
in your state or community, either on the slide or in your discussion/presentation.  

 

Slide 18 

"Your State Project"

How Can We Create Positive Youth Development 
Opportunities?

• Provide safe places for youth to go: after-school programs, extracurricular activities, 
community centers

• Provide places for youth to do challenging things:  academic support/mentoring; 

• Provide service learning; youth 
empowerment/organizing; career development; culture, 
arts and media; recreation

• Provide places for youth to do these things with caring adults and with supportive 
peers

• Provide, most fundamentally, places that seek to promote positive youth 
development.

 
Note to Facilitator:  
This slide is an appropriate place to provide examples of youth development programming 
in your state or community, either on the slide or in your discussion/presentation.  

 

Slide 19 

"Your State Project"

How Can We Create Positive Youth Development 
Opportunities?

• Provide safe places for youth to go: after-school programs, extracurricular 
activities, community centers

• Provide places for youth to do challenging things:  academic 
support/mentoring; 

• Provide service learning; youth empowerment/organizing; career 
development; culture, arts and media; recreation

• Provide places for youth to do these things with 
caring adults and with supportive peers

• Provide, most fundamentally, places that seek to promote positive youth 
development.

 
Note to Facilitator:  
This slide is an appropriate place to provide examples of youth development programming 
in your state or community, either on the slide or in your discussion/presentation.  
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Slide 20 

"Your State Project"

How Can We Create Positive Youth Development 
Opportunities?

• Provide safe places for youth to go: after-school programs, extracurricular 
activities, community centers

• Provide places for youth to do challenging things:  academic 
support/mentoring; 

• Provide service learning; youth empowerment/organizing; career 
development; culture, arts and media; recreation

• Provide places for youth to do these things with caring adults and with 
supportive peers

• Provide, most fundamentally, places that seek to 
promote positive youth development.

 
Note to Facilitator:  
This slide is an appropriate place to provide examples of youth development programming 
in your state or community, either on the slide or in your discussion/presentation.  

 

Slide 21 

"Your State Project"

Organizing Framework

Community

School

Family

The
Developing 

Youth

 
Note to Facilitator:  
The Components of the organizing framework for this presentation are: community, school 
and family.  

Each of these influences the developing youth. This presentation will address each of 
these components-community, school and family separately. 

 

Slide 22 

"Your State Project"

Community Connectedness

 
Note to Facilitator:  
This space intentionally left blank. 
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Slide 23 

"Your State Project"

Community Connectedness and Non-
School-Hour Programming

Community

Community

School

Family

The
Developing 

Youth

 
Note to Facilitator:  
This is the introductory slide for the “community connectedness” section. 

Slide 24 

"Your State Project"

What is Community Connectedness?

Young people feel connected to their community 
when… 

• They are involved in meaningful ways,
• They have respect and appreciation for 

diversity, and
• They have the ability to contribute.

 
Note to Facilitator:   
Relevant Research 
     CSR, Incorporated. (1997). Understanding youth development: Promoting positive 
pathways of growth. Retrieved Jan. 30, 2001 from http://www.ncfy.com/Understanding-
YD.htm 
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Slide 25 

"Your State Project"

Voices of Youth

“Quote from local youth about 
the role of community 
connectedness.”

[Insert Program Name]

 
Note to Facilitator:  
This is an appropriate place to insert actual quotes and photos or video clips from youth 
involved in your community programming.  

It is important to integrate youth voices into the presentation wherever possible as it adds 
richness to the statistical data.  

To insert a quote, click on the text, delete what is currently there and type in the new text. 

 
PowerPoint Tip 
To insert video 

1. Make sure the video clip is saved on your computer. 

2. From the top menu bar - select "Insert" > "Movies and sounds." 
3. Then select "Movie from file." 
4. Browse to the location of the video file on your computer (e.g. My documents\my 

videos). 

5. Select the desired video file and it should appear on the slide. 

6. You may then resize the file and place it where you would like. 

7. Test the file to make sure it plays correctly. 

Note: 
During the presentation, the video file will start like other animations, by clicking your 
mouse. 

Most popular video formats (.avi, .wmv) should work. 

Adding movie files to your presentation increases the size of the file dramatically. This is 
something to keep in mind if you are planning on sending the presentation through email. 
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Slide 26 

"Your State Project"

Why is Community Connectedness Important?

“Each community must create a 
vision of what it wants for all young 
people. Only then can those 
communities create an environment 
in which young people can achieve 
their greatest potential, through 
supports, services, and 
opportunities.” 

Family and Youth Services Bureau

 
Note to Facilitator:  
Relevant Research 
      National Clearinghouse on Families and Youth. (1996). Reconnecting youth & 
community: A youth development approach. Retrieved Jan. 30, 2001 from 
http://www.ncfy.com/Reconnec.htm. 

 

Slide 27 

Note to Facilitator:  
Change title of chart to reflect your state or community. 

Click on the words at the top of the chart in green and delete the words “your state.”   

In its place, type in the name of your state or community.  Make sure the data that you are 
going to put in the chart is for the state or community that you named.  

The three lines of the chart are three possible statistics that you may be able to report.  If 
you cannot find these particular statistics, there are a number of other community level 
indicators that would also work well, for example:  

 % living in poverty. 

 Number of juveniles detained, incarcerated, or placed in residential facilities.  

 Percent of young adults who are disconnected. 

 Youth participation in volunteer activities. 

There are a number of reliable national sources for this type of data.  We have suggested 
several below.  

Census:  
http://www.census.gov/acs/www/Products/Profiles/Single/2003/ACS/index.htm or 
http://www.census.gov/acs/www/Products/Ranking/index.htm. 

 

"Your State Project"

The Need…

Source of statistics

Youth in [your state] report:

XX.X%Gang Involvement

XX.X%Communities Disorganized

XX.X%Low Neighborhood Attachment

"Your State Project"

The Need…

Source of statistics

Youth in [your state] report:

XX.X%Gang Involvement

XX.X%Communities Disorganized

XX.X%Low Neighborhood Attachment
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National and/or State Youth Risk Behavior Surveys:  
http://www.cdc.gov/HealthyYouth/YRBS/statefacts.htm. 

National Center for Education Statistics: 
http://nces.ed.gov/edstats/. 

ChildStats: 
http://www.childstats.gov/. 

Annie E Casey Foundation: 
http://www.aecf.org/kidscount/data.htm - Four types of data to search, but clear and easy 
to use. 

Education Counts:  
http://www.edweek.org/rc/index.html - You may need to register to use this site.  Go to 
“customize your data” and then select from the categories. Consider looking in the “school 
climate” section for indicators.   

Additionally, it is likely that your state or local departments of health and/or education or 
local universities may have data available as well. 

Once you have selected the data you wish to report, click on the lines of the table and 
delete any text that isn’t appropriate. Type in the indicator on the left and the value on the 
right.   

Click on the box that says “source of statistics” and type in the reference for the statistics 
you reported above. 

Slide 28 

"Your State Project"

Community Connections are Protective
Sexual 
Debut

Substance 
UseViolence

Youth-Adult Partnerships

Caring Adults

Community Service

Allen, J. P., Philliber, S., Herrling, S., & Kupermine, G. P. (1997). Preventing teen pregnancy and academic failure: Experiential evaluation of a developmentally 
based approach. Child Development, 68.

Aseltine, R.H., Dupre, M., & Lamlein, P. (2000). Mentoring as a drug prevention strategy: An evaluation of across ages. Adolescent & Family Health, 1(1), 11-20. 
Kirby, D., & Coyle, K. (1997). Youth development programs. Children and Youth Services Review, 19, 437-454.
Melchior, A. (1999, July). Summary Report: National Evaluation of Learn and Serve America. Waltham, MA: Center for Human Resources, Brandeis University.
Tierney, J. P., Grossman, J. B., with Resch, N. L. (1995). Making a difference: An impact study of Big Brothers/Big Sisters. Philadelphia, PA: Public/Private 

Ventures. 
Zeldin, S., McDaniel, A. K., Topitzes, D., & Calvert, M. (2000). Youth in decision-making: A study on the impacts of youth on adults and organizations. Innovation 

Center/Tides Center and University of Wisconsin Extension.

 
Note to Facilitator:  
Relevant Research 
Allen, J. P., Philliber, S., Herrling, S., & Kupermine, G. P. (1997). Preventing teen 
pregnancy and academic failure: Experiential evaluation of a developmentally based 
approach. Child Development, 68. 

 This article describes the association between community service activities and the delay 
of sexual debut. 

     Aseltine, R.H., Dupre, M., & Lamlein, P. (2000). Mentoring as a drug prevention 
strategy: An evaluation of across ages. Adolescent & Family Health, 1(1), 11-20.  

This article describes an evaluation of a mentoring program and the effectiveness of this 
approach as a drug prevention strategy. 
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    Kirby, D., & Coyle, K. (1997). Youth development programs. Children and Youth 
Services Review, 19, 437-454. 

 This article provides evidence for the relationship between youth and adult partnerships 
and the reduction of sexual debut among youth. 

     Melchior, A. (1999, July). Summary Report: National Evaluation of Learn and Serve 
America. Waltham, MA: Center for Human Resources, Brandeis University. 

     Tierney, J. P., Grossman, J. B., with Resch, N. L. (1995). Making a difference: An 
impact study of Big Brothers/Big Sisters. Philadelphia, PA: Public/Private Ventures.  

This report provides information substantiating the connection between exposure to caring 
adults and reduction in substance abuse and violence among young people. 

     Zeldin, S., McDaniel, A. K., Topitzes, D., & Calvert, M. (2000). Youth in decision-
making: A study on the impacts of youth on adults and organizations. Innovation 
Center/Tides Center and University of Wisconsin Extension. 

 

Slide 29 

"Your State Project"

Community Connections are Developmental

Community connections and youth voice result in 
increasing:

• Positive beliefs about self
• Identity exploration, taking initiative
• Positive attitudes towards adults
• Social skills and teamwork
• Communication and planning skills

Zeldin, R. S., Camino, L., & Calvert, M. (2003). Toward an understanding of youth in community governance: Policy priorities and research directions. Social 
Policy Report, XVII, 3.  Retrieved September 13, 2005 from http://www.srcd.org/Documents/Publications/SPR/spr17-3.pdf

Zeldin, S., McDaniel, A. K., Topitzes, D., & Calvert, M. (2000). Youth in decision-making: A study on the impacts of youth on adults and organizations.
Innovation Center/Tides Center and University of Wisconsin Extension.

 
Note to Facilitator:  
Relevant Research 
     Zeldin, R. S., Camino, L., & Calvert, M. (2003). Toward an understanding of youth in 
community governance: Policy priorities and research directions. Social Policy Report, 
XVII, 3.  Retrieved September 13, 2005 from 
http://www.srcd.org/Documents/Publications/SPR/spr17-3.pdf 

     Zeldin, S., McDaniel, A. K., Topitzes, D., & Calvert, M. (2000). Youth in decision-
making: A study on the impacts of youth on adults and organizations. Innovation 
Center/Tides Center and University of Wisconsin Extension. 

 

Slide 30 

"Your State Project"

Supports and Opportunities for Community 
Connections and Youth Voice:

• Opportunities exist for community involvement
• Community service opportunities are available for 

youth 
• Opportunities for youth to make decisions
• Opportunities for youth to care about others
• Opportunities to participate in youth/adult 

partnerships

 
Note to Facilitator:  
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Here are some suggestions for possible supports and opportunities.  For more information 
on these, see the special issue of Journal of Community Psychology (2005, Volume 33, 
Issue 1) titled, “Youth-Adult Relationships in Community Programs: Diverse Perspectives 
on Good Practices.”  It is edited by Shepherd Zeldin, Reed Larson, and Linda Camino.  

You may choose to incorporate other supports and opportunities into this slide.  These may 
come from a mission statement or shared vision.   

For more information on developing these goals, see:  

Building Community:  A Tool Kit for Youth and Adults in Charting Assets and Creating 
Change at: 

http://www.theinnovationcenter.org or  

http://www.CYFERnet.org. 

 

Slide 31 

"Your State Project"

Practical Applications

Young people create long-lasting 
solutions to community problems 
they care about by:

• Helping to shape their own activities in 
the program

• Involving them in issues that matter to 
them

• Taking on age-appropriate adult roles 
and responsibilities

Examples can be 
seen in programs 

such as 

“Earth Force 
After School” at

bpy.n4h.org

 
Note to Facilitator:  
Example Curriculum 
     Earth Force. Retrieved September 19, 2005 from http://www.earthforce.org. 

 This web site provides examples of community action / problem solving youth 
development programs that can be used in a community program setting. 

 

Slide 32 

"Your State Project"

Prepare for Action

Discussion Points:
• What do you/does your organization already do to 

promote Community Connectedness?
• What resources do you/does your organization 

bring to the table that will foster a coordinated 
approach to Community Connectedness?

 
Note to Facilitator:  
The “prepare for action” sections are intended to stimulate discussion. Before making the 
presentation, decide how you would like to structure this section.   

Will this section consist of a series of small group discussions with participants reporting to 
the larger group at the end?   

Or would you prefer people think about this quietly in their seats and ask only a few 
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participants to respond out loud?   

There are many ways to structure this discussion.  What is important is that you carefully 
consider your audience and plan your approach in advance. The questions on the slide 
were designed to stimulate small group discussions that would lead to increased 
collaboration, coordination and partnerships. Your goals may differ.   

 

If so, it may make sense to change these questions so they more directly relate to the 
goals of the presentation.   

If you decide on new questions, click on the text, delete the current text and type in the new 
questions.  

 

Slide 33 

"Your State Project"

School Connectedness

 
Note to facilitator: 
This is the introductory slide to the section on “school connectedness.” 

Slide 34 

"Your State Project"

School Connectedness & Non-School-Hour 
Programming

School

Community

School

Family

The
Developing 

Youth

 
Note to facilitator: 
This space intentionally left blank. 
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Slide 35 

"Your State Project"

What is School Connectedness?

Young people feel connected to their schools 
when… 

• They feel close to people at school,
• Are all treated fairly and equally, 
• Get along with teachers and peers, and
• Are involved in school decisions.

 
Note to Facilitator:  
Relevant Research 
McNeely C. A., Nonnemaker J.M., Blum R.W.(2002).  Promoting School Connectedness: 
Evidence from the National Longitudinal Study of Adolescent Health. Journal of School 
Health,72, 138.  

This article provides evidence that young people who experience caring relationships with 
others at their school and who feel a part of their school are less likely to use substances, 
engage in violence, or initiate sexual activity at an early age. This study uses data from the 
in-school and school administrator surveys of the National Longitudinal Study of 
Adolescent Health (75,515 students in 127 schools).  

 

Slide 36 

"Your State Project"

Voices of Youth…

“Insert youth quote on 
importance of school 
connectedness”

[Insert your local 
program name here]

 
Note to Facilitator:  
This is an appropriate place to insert actual quotes (and photos) from local youth.  

It is important to integrate youth voices into the presentation wherever possible as it adds 
richness to the statistical data.  

To insert a quote, click on the text, delete what is currently there and type in the new text. 
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Slide 37 

"Your State Project"

Why is School Connectedness Important?

“American adolescents stand a better 
chance of avoiding risky behavior when 
they experience and express strong 
connections to their school.” 

Blum & Rinehart, 1997

 
Note to Facilitator:   
Relevant Research 
     Blum, R. W., & Rinehart, P. M. (1997). Reducing the risk: Connections that make a 
difference in the lives of youth.  Bethesda, MD: Add Health. Retrieved September 13, 2005 
from http://allaboutkids.umn.edu/cfahad/Reducing_the_risk.pdf.   

This on-line report provides research-based information substantiating the health and 
behavioral benefits of family and school connections for young people.  

 

Slide 38 

"Your State Project"

The need…

Source of statistics 

Youth in [your state] report:

XX.X%Feeling Rewarded for Positive Involvement

XX.X%Opportunities for Positive Involvement

XX.X%Low School Commitment

 
Note to Facilitator:  
Change the title of the chart to reflect your state or community. 

Click on the words at the top of the chart in green and delete the words [your state].  In its 
place, type in the name of your state or community.   

Make sure the data that you are going to put in the chart is for the state or community that 
you named.   

The three lines of the chart are three possible statistics that you may be able to report.  If 
you cannot find these particular statistics there are a number of other school indicators that 
would also work well, for example: 

 School Enrollment. 

 High School Graduation Rates. 

 Received mostly D’s and F’s in school. 

 Teacher/Student ratio. 

There are a number of reliable national sources for this type of data.  We have suggested 
several below.  
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Census:  
http://www.census.gov/acs/www/Products/Profiles/Single/2003/ACS/index.htm or 
http://www.census.gov/acs/www/Products/Ranking/index.htm. 

National and/or State Youth Risk Behavior Surveys:  
http://www.cdc.gov/HealthyYouth/YRBS/statefacts.htm. 

National Center for Education Statistics: 
http://nces.ed.gov/edstats/. 

ChildStats: 
http://www.childstats.gov/. 

Annie E Casey Foundation: 
http://www.aecf.org/kidscount/data.htm - Four types of data to search, but clear and easy 
to use. 

Education Counts:  
http://www.edweek.org/rc/index.html - You may need to register to use this site.  Go to 
“customize your data” and then select from the categories. Consider looking in the “school 
climate” section for indicators.   

Additionally, it is likely that your state or local departments of health and/or education or 
local universities may have data available as well. 

Once you have selected the data you wish to report, click on the lines of the table and 
delete any text that isn’t appropriate. Type in the indicator on the left and the value on the 
right.   

Click on the box that says “source of statistics” and type in the reference for the statistics 
you reported above. 

 

 

Slide 39 

"Your State Project"

School Connections are Protective
Sexual 
Debut

Substance 
UseViolence

School Attendance

High Aspirations

School Connectedness

Blum, R.W., Beuhring,T., Rinehart, P.M., (2000). Protecting teens: Beyond race, income and family structure, Center For Adolescent Health, University of 
Minnesota, 200 Oak Street SE, Suite 260, Minneapolis, MN. Retrieved September 12, 2005 from http://ideanet.doe.state.in.us/sdfsc/pdf/protectingteens.pdf

Catalano, R. F., Berglund, M. L., Ryan, J. A. M., Lonczak, H. S., & Hawkins, J. D. (1998). In Positive youth development in the United States: Research 
findings on evaluations of positive youth development programs. Retrieved September 13, 2005 from 
http://aspe.hhs.gov/hsp/PositiveYouthDev99/chapter2.htm. 

Hawkins, J.D., Catalano, R.F., Kosterman, R., Abbott, R., & Hill, K.G. (1999) Preventing Adolescent Health-Risk Behaviors by Strengthening Protection 
During Childhood. Archives of Pediatric and Adolescent Medicine, 153: 226-234.

Lloyd-Richardson, E.; Papandonatos, G.; Kazura, A. (2002). Differentiating stages of smoking intensity among adolescents: Stage-specific psychological 
and social influences. Journal of Consulting and Clinical Psychology, 70, 998-1009. 

McNeely C. A., Nonnemaker J.M., Blum R.W.(2002).  Promoting School Connectedness: Evidence from the National Longitudinal Study of Adolescent 
Health. Journal of School Health,72, 138. 

 
Note to Facilitator:  
Relevant Research 
     Blum, R.W., Beuhring,T., Rinehart, P.M., (2000). Protecting teens: Beyond race, income 
and family structure, Center For Adolescent Health, University of Minnesota, 200 Oak 
Street SE, Suite 260, Minneapolis, MN. Retrieved September 12, 2005 from 
http://ideanet.doe.state.in.us/sdfsc/pdf/protectingteens.pdf 
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     Catalano, R. F., Berglund, M. L., Ryan, J. A. M., Lonczak, H. S., & Hawkins, J. D. 
(1998).  In Positive youth development in the United States: Research findings on 
evaluations of positive youth development programs. Retrieved September 13, 2005 from 
http://aspe.hhs.gov/hsp/PositiveYouthDev99/chapter2.htm.  

This on-line document provides definitions of Positive Youth Development concepts and 
detailed descriptions and evaluation findings of community programs promoting school 
connectedness. 

     Hawkins, J.D., Catalano, R.F., Kosterman, R., Abbott, R., & Hill, K.G. (1999) Preventing 
Adolescent Health-Risk Behaviors by Strengthening Protection During Childhood. Archives 
of Pediatric and Adolescent Medicine, 153: 226-234.  

     Lloyd-Richardson, E.; Papandonatos, G.; Kazura, A. (2002). Differentiating stages of 
smoking intensity among adolescents: Stage-specific psychological and social influences. 
Journal of Consulting and Clinical Psychology, 70, 998-1009.  

This article uses national data to examine school and family connectedness as a protective 
factor to smoking. 

     McNeely C. A., Nonnemaker J.M., Blum R.W. (2002).  Promoting School 
Connectedness: Evidence from the National Longitudinal Study of Adolescent Health. 
Journal of School Health, 72, 138.  

This article provides evidence that young people who experience caring relationships with 
others at their school and who feel a part of their school are less likely to use substances, 
engage in violence, or initiate sexual activity at an early age. This study uses data from the 
in-school and school administrator surveys of the National Longitudinal Study of 
Adolescent Health (75,515 students in 127 schools).  

 
 

Slide 40 

"Your State Project"

School Connections are Developmental…

School connections and youth involvement in 
school decision-making result in increasing:

• Academic achievement
• Civic competence
• Sense of community
• Pro-social attitudes and behaviors

Special issue of Journal of School Health (2004), School Connectedness-Strengthening Health and Education Outcomes for Teenagers, 74(7).

 
Note to Facilitator:  
Relevant Research 
Special issue of Journal of School Health (2004), School Connectedness-Strengthening 
Health and Education Outcomes for Teenagers, 74(7). 
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Slide 41 

"Your State Project"

Supports & Opportunities for School 
Connectedness:

• Support high academic and behavioral 
expectations

• Encourage active involvement
• Encourage goal setting, academic 

achievement, and positive social 
development

 
Note to Facilitator:  
Relevant Research 
Special issue of Journal of School Health (2004, Volume 74, Issue 7). School 
Connectedness-Strengthening Health and Education Outcomes for Teenagers. 

 

Slide 42 

"Your State Project"

Practical Application:

Examples for creating school 
connectedness include activities 
that:

• Actively involve youth in researching 
and taking action on issues important 
to them within their schools and 
communities 

• Empower young people to promote 
peaceful solutions to problems

Examples can be 
seen in programs 

such as 

“Public Adventures” 
at

bpy.n4h.org

 
Note to Facilitator:  
 

Slide 43 

"Your State Project"

Prepare for Action

Discussion Points:
• What do you/does your organization already do 

to promote School Connectedness?
• What resources do you/ does your organization 

bring to the table that will foster a coordinated 
approach to School Connectedness?

 
Note to Facilitator:  
The “prepare for action” sections are intended to stimulate discussion. Before making the 
presentation, decide how you would like to structure this section.   

Will this section consist of a series of small group discussions with participants reporting to 
the larger group at the end?   

Or would you prefer people think about this quietly in their seats and ask only a few 
participants to respond out loud?   

There are many ways to structure this discussion.  What is important is that you carefully 
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consider your audience and plan your approach in advance. The questions on the slide 
were designed to stimulate small group discussions that would lead to increased 
collaboration, coordination and partnerships.  Your goals may differ.   

If so, it may make sense to change these questions so they more directly relate to the 
goals of the presentation.   

If you decide on new questions, click on the text, delete the current text and type in the new 
questions.  

 

 

Slide 44 

"Your State Project"

Family Connectedness

 
Note to Facilitator:  
This is the introductory slide to the “family connectedness” section. 

 

Slide 45 

"Your State Project"

Family Connectedness & Non-School-Hour 
Programming

Family

Community

School

Family

The
Developing 

Youth

 
Note to Facilitator:  
This space intentionally left blank. 
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Slide 46 

"Your State Project"

What is Family Connectedness?

“Parent-child connectedness can be defined as the 
degree of closeness/warmth experienced in the 
relationships that children have with their 
parents.”

Resource Center for Adolescent 
Pregnancy Prevention (ETR)

 
Note to Facilitator:  
Relevant Research 
     Resource Center for Adolescent Pregnancy Prevention. (2004). Parent-child 
connectedness.  Retrieved on September 22, 2005 from 
http://www.etr.org/recapp/column/column200401.htm. 

This on-line report written by researchers at Education Training Research (ETR) provides 
information pertaining to the benefits on parent-child connectedness.  

 

Slide 47 

"Your State Project"

Importance of Family Connectedness…

“When teens feel connected to their families and 
when parents are involved in their children’s 
lives, teens are protected.” 

Blum & Rinehart, 1997

 
Note to Facilitator:  
Relevant Research 
      Blum, R. W., & Rinehart, P. M. (1997). Reducing the risk: Connections that make a 
difference in the lives of youth.  Bethesda, MD: Add Health. Retrieved September 13, 2005 
from http://allaboutkids.umn.edu/cfahad/Reducing_the_risk.pdf.   

This on-line report provides research-based information substantiating the health and 
behavioral benefits of family and school connections for young people.  

 

Slide 48 

"Your State Project"

The Need…

Source of statistics

Youth in [your state] report:

XX.X%Family Attachment

XX.X%Poor Parental Supervision

XX.X%Family Conflict
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Note to Facilitator:  
Change the title of the chart to reflect your state or community. 

Click on the words at the top of the chart in green and delete the words [your state].  In its 
place, type in the name of your state or community.  Make sure the data that you are going 
to put in the chart is for the state or community that you named.   

The three lines of the chart are three possible statistics that you may be able to report.  If 
you cannot find these particular statistics, there are a number of other school indicators 
that would also work well, for example: 

 Family Involvement in School. 

 Family Closeness. 

 Parental Warmth.  

 Child Support Received. 

There are a number of reliable national sources for this type of data.  We have suggested 
several below.  

Census:  
http://www.census.gov/acs/www/Products/Profiles/Single/2003/ACS/index.htm or 
http://www.census.gov/acs/www/Products/Ranking/index.htm. 

National and/or State Youth Risk Behavior Surveys:  
http://www.cdc.gov/HealthyYouth/YRBS/statefacts.htm. 

National Center for Education Statistics: 
http://nces.ed.gov/edstats/. 

ChildStats: 
http://www.childstats.gov/. 

Annie E Casey Foundation: 
http://www.aecf.org/kidscount/data.htm - Four types of data to search, but clear and easy 
to use. 

Education Counts:  
http://www.edweek.org/rc/index.html - You may need to register to use this site.  Go to 
“customize your data” and then select from the categories. Consider looking in the “school 
climate” section for indicators.   

Additionally, it is likely that your state or local departments of health and/or education or 
local universities may have data available as well. 

 

Once you have selected the data you wish to report, click on the lines of the table and 
delete any text that isn’t appropriate. Type in the indicator on the left and the value on the 
right.   

Click on the box that says “source of statistics” and type in the reference for the statistics 
you reported above. 
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Slide 49 

"Your State Project"

Family Connections are Protective
Sexual 
Debut

Substance 
UseViolence

School Expectations

Parental Presence

Family Connectedness

Lloyd-Richardson, E., Papandonatos, G., Kazura, A. (2002). Differentiating stages of smoking intensity among adolescents: Stage-specific psychological 
and social influences. Journal of Consulting and Clinical Psychology, 70, 998-1009. 

Pilgrim, C., Abbey, A., Hendrickson, P. (1998). Implementation and impact of a family-based substance abuse prevention program in rural communities. 
Journal of Primary Prevention, 18, 341-361. 

Rayburn, C. A., Richmond, L. J.(2001). Peacefulness, spirituality, and Violence prevention. In D. S. Sandhu (Ed.) Faces of violence: Psychological 
correlates, concepts, and intervention strategies. Huntington, NY: Nova Science Publishers, Inc. pp. 455-464. 

ReCAPP (n.d.). Parent-child connectedness. ETR. Retrieved on September 13, 2005 from  http://www.etr.org/recapp/column/column200401.htm. 
Resnick, M.D., Bearman, P.S., Blum, R.W., Bauman, K.E., Harris, K.M., Jones, J., Tabor, J., Beuhrigh, T., Sieving, R.E., Shew, M., Ireland, M., Bearinger, 

L.H., Udry, J.R. (1997). Protecting adolescents from harm: Findings from the National Longitudinal Study of Adolescent Health. Journal of the American 
Medical Association, 278, 823-832.

Scales, P., Ireland, M., Borowshky, I. W.(2003). Smoking among American adolescents: A risk and protective factor analysis. The Publication for Health 

Promotion and Disease Prevention, 28, 79-97.

 
Note to Facilitator:  
Relevant Research 
     Lloyd-Richardson, E., Papandonatos, G., Kazura, A. (2002). Differentiating stages of 
smoking intensity among adolescents: Stage-specific psychological and social influences. 
Journal of Consulting and Clinical Psychology, 70, 998-1009.  

This article uses national data to examine school and family connectedness as a protective 
factor to smoking. 

     Pilgrim, C., Abbey, A., Hendrickson, P. (1998). Implementation and impact of a family-
based substance abuse prevention program in rural communities. Journal of Primary 
Prevention, 18, 341-361. 

This article suggests that improved communication skills between parents and youth is an 
effective strategy for preventing substance abuse. 

     Rayburn, C. A., Richmond, L. J. (2001). Peacefulness, spirituality, and Violence 
prevention. In D. S. Sandhu (Ed.) Faces of violence: Psychological correlates, concepts, 
and intervention strategies. Huntington, NY: Nova Science Publishers, Inc. pp. 455-464.  

This chapter suggests that family connections and increases awareness of diversity and an 
understanding of the need to share resources, among other strategies, helps lessen the 
problems of violence. 

     Resource Center for Adolescent Pregnancy Prevention (2004). Parent-child 
connectedness. ETR. Retrieved on September 13, 2005 from  
http://www.etr.org/recapp/column/column200401.htm.  

This on-line report written by researchers at Education Training Research (ETR) provides 
information pertaining to the benefits on parent-child connectedness.  

     Resnick, M.D., Bearman, P.S., Blum, R.W., Bauman, K.E., Harris, K.M., Jones, J., 
Tabor, J., Beuhrigh, T., Sieving, R.E., Shew, M., Ireland, M., Bearinger, L.H., Udry, J.R. 
(1997). Protecting adolescents from harm: Findings from the National Longitudinal Study of 
Adolescent Health. Journal of the American Medical Association, 278, 823-832. 

    Scales, P., Ireland, M., Borowshky, I. W.(2003). Smoking among American adolescents: 
A risk and protective factor analysis. The Publication for Health Promotion and Disease 
Prevention, 28, 79-97.  

This article examines the relationship between family connectedness and smoking. 
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Slide 50 

"Your State Project"

Family Connections are Developmental…

Family connections and youth involvement in 
family decision-making results in increasing:

• Intrinsic motivation
• Self-esteem
• Identity development 
• Role- taking skills
• Successful school transitions

Ginsberg, G.S., Bronstein, P. (1993). Family factors related to children's intrinsic/extrinsic motivational orientation and academic performance. Child 
Development, 64, 1461-1474. 

Kurdek, L..A., Fine, M.A. & Sinclair, R.J. (1995). School adjustment in sixth graders: parenting transitions, family climate, and peer norm effects. Child 
Development, 66, 430-445.

Matheis, S. & Adams, G. (2004). Family climate and identity style during late adolescence. Identity: An International Journal of Theory and Research, 4(1), 
77-95. 

Yabiku, S. T., Axinn, W. G., and Thornton, A. (1999). Family integration and children's self-esteem. American Journal of Sociology, 104, 1494-1524.
. 

 
Note to facilitator:  
Relevant Research 
    Ginsberg, G.S., Bronstein, P. (1993).  Family factors related to children's 
intrinsic/extrinsic motivational orientation and academic performance. Child Development, 
64, 1461-1474.  
     Kurdek, L..A., Fine, M.A. & Sinclair, R.J. (1995).  School adjustment in sixth graders: 
parenting transitions, family climate, and peer norm effects. Child Development, 66, 430-
445. 
     Matheis, S. & Adams, G. (2004).  Family climate and identity style during late 
adolescence. Identity: An International Journal of Theory and Research, 4(1), 77-95.  
     Yabiku, S. T., Axinn, W. G., and Thornton, A. (1999). Family integration and children's 
self-esteem. American Journal of Sociology, 104, 1494-1524. 
.   

 

 

Slide 51 

"Your State Project"

Supports & Opportunities for Family 
Connectedness:

• Close family relationships
• Family members are nurturing and supportive of 

each other
• Education is valued

Hawaii Youth Substance Abuse 
Prevention Strategy, 2001

 
Note to facilitator:  
Relevant Research 
     Hawaii Department of Health Alcohol and Drug Abuse Division (2001). Hawaii youth 
substance abuse prevention strategy. Honolulu, HI: Hawaii Department of Health Alcohol 
and Drug Abuse Division, Author. The Youth Substance Abuse Prevention. 
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Slide 52 

"Your State Project"

Practical Application:

Examples for creating family 
connectedness include activities 
that encourage young people and 
their parents to:

• talk with each other about family values 
and customs

• spend time engaged in enjoyable 
activities

• talk about sensitive issues
• make decisions and be involved in their 

communities together

Examples can be 
seen in programs 

such as 

“Too Good for Drugs 
and Violence 

Afterschool 
Activities” at 

bpy.n4h.org

 
Note to Facilitator:  
Additional information on Too Good for Drugs and Violence Afterschool Activities was 
retrieved September 19, 2005 from http://www.mendezfoundation.org 

 

Slide 53 

"Your State Project"

Prepare for Action

Discussion Points:
• What do you/does your organization already do 

to promote Family Connectedness?
• What resources do you/ does your organization 

bring to the table that will foster a coordinated 
approach to Family Connectedness?

 
Note to Facilitator:  
The “prepare for action” sections are intended to stimulate discussion. Before making the 
presentation, decide how you would like to structure this section.   

Will this section consist of a series of small group discussions with participants reporting to 
the larger group at the end?   

Or would you prefer people think about this quietly in their seats and ask only a few 
participants to respond out loud?   

There are many ways to structure this discussion.  What is important is that you carefully 
consider your audience and plan your approach in advance. The questions on the slide 
were designed to stimulate small group discussions that would lead to increased 
collaboration, coordination and partnerships.  Your goals may differ.   

If so, it may make sense to change these questions so they more directly relate to the 
goals of the presentation.   

If you decide on new questions, click on the text, delete the current text and type in the new 
questions.  

 

 

 

31 of 35



Slide 54 

"Your State Project"

Summary

 
Note to facilitator: 
Introductory slide to the “summary” section. 

 

Slide 55 

"Your State Project"

Making the Connections for Non-School-
Hour Programming

Community

School

Family

Community

School

Family

The
Developing 

Youth

 
Note to facilitator: 
This space intentionally left blank. 

Slide 56 

"Your State Project"

Connections are Protective

Sexual 
Debut

Substance 
UseViolence

School Connectedness

Family Connectedness

Community 
Connectedness

 
Note to facilitator: 
This chart evidences how the three levels protect youth from risk behaviors. 
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Slide 57 

"Your State Project"

Moving toward Collaboration

• What resources do you/ does your organization 
bring to the table that will foster a coordinated 
approach to non-school-hour youth development 
programming?

 
Note to facilitator: 
Prompt the audience to provide examples of resources that they can “bring to the table.” 

 

Slide 58 

"Your State Project"

Moving toward Collaboration 

• Given that we have all of these resources, what 
are the barriers to a more coordinated approach 
to non-school-hour youth development 
programming?

 
Note to facilitator: 
Prompt your audience to provide examples of barriers. 

You may want to provide barriers that your organization has experienced as a way to begin 
the discussion. 

Slide 59 

"Your State Project"

Moving toward Collaboration 

• What are the concrete steps needed to 
coordinate our resources to overcome these 
barriers?

 
Note to facilitator: 
Prompt audience to provide concrete steps to take to better coordinate efforts. 

Discuss how a barrier you have experienced has been overcome.  

 What resources did you use to do it? 

 Who helped you? 

 What did you learn? 
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Slide 60 

"Your State Project"

Moving toward Collaboration 

• Who is willing to take some of the ownership of 
these next steps?

 
Note to facilitator: 
Strongly encourage your group to identify individuals or groups who are willing to be 
responsible for overseeing the implementation of next steps.   

Provide suggestions of how individuals or groups could share responsibility based on 
existing resources discussed earlier. 

Slide 61 

"Your State Project"

Thank you

 
Note to facilitator:  
Be sure to thank your audience. 

Thank collaborators who helped in this process. 

Slide 62 

"Your State Project"

Acknowledgements
The template for this presentation was developed by the 

following:

• Building Partnerships for Youth Project
• Karen Hoffman Tepper, Ph.D. 
• Dan McDonald, Ph.D. 
• James Roebuck, M.A.
• Dr. Richard Shepherd Zeldin, University of Wisconsin, Madison
• Hawaii Department of Health 
• Family Health Services Division, Maternal and Child Health Branch
• Alcohol and Drug Abuse Division
• Hawaii Building Partnerships for Youth Planning Committee
• Centers for Disease Control and Prevention – Division of Adolescent 

Health

 
Note to facilitator: 
This PowerPoint-based tool would not be possible without the hard work of these people 
and organizations. 

We ask that you do not remove this slide. 

While we do not expect you to read aloud everyone listed, we suggest:  

“The following individuals and organizations are responsible for putting this tool together. 
For more information, please visit: http://bpy.n4h.org/  
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Slide 63 

"Your State Project"

Building Partnerships for Youth Project

http://bpy.n4h.org/

This document was supported by a Grant/Cooperative Agreement Number U87/CCU318437-05 from 
the Centers for Disease Control and Prevention. The contents of this document are solely the 

responsibility of the authors and do not necessarily represent the official views of the Centers for 
Disease Control and Prevention.

 
Note to facilitator: 
Building Partnerships for Youth is collaboration between the University of Arizona and 
National 4-H Council. 

 

 

 

 

This document was supported by a Cooperative Agreement Number U87/CCU318437-05 from the Centers for Disease 
Control and Prevention. The contents of this document are solely the responsibility of the authors and do not necessarily 

represent the official views of the Centers for Disease Control and Prevention. 
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